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Mac Basic

Intro to Pages App
From Pages App Help Menu
Start with a Template
All of the information in this article and
more can be found in the Help menu in the
Pages application.
You can use Pages to create any kind of
document you want, from a simple
word-processing document that’s mainly
text, to a page layout document like a
newsletter with graphics, interesting font
treatments, and more.
To create any document, you always
start with a template, then modify it
however you like. The templates are
designed for specific purposes—like
essays, newsletters, and books—to give
you a great starting point for your work.

After you open a template, you can add
your own text, replace placeholder
graphics or delete them, and add new
objects (tables, charts, text boxes, shapes,
lines, and media).
To modify text and objects in your
document, you use the formatting and
layout controls in the sidebar on the right
side of the Pages window (shown at right).
The sidebar shows only controls for the
text or object you selected.

Other sidebars (on the right and
left) have controls to format your
document, review comments and
changes, view page thumbnails to
navigate the document, and more.
You can quickly change the look of
a selected object (image, shape,
table, or chart) by clicking one of
the six styles near the top of the
Continued on next page
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Format sidebar. Use the other controls in the • Word-processing: Used to create
documents that include mainly text, like
sidebar to customize the object however you
reports or letters, but can also include
like. For more formatting options, click the
images. These documents have a body
tabs at the top of the sidebar.
text area where you type, and the text
flows from one page to the next, with
new pages created automatically when
you reach the end of the page.
When you open a word-processing
document (or template), you can just
start typing. If you want to add text
that’s separate from the main body text,
you can add a text box. You can also
add images, charts, and other objects.
• Page layout: Used to create documents
with a more custom design, like
newsletters, books, or posters. A page
layout document is like a canvas that
you add text boxes, images, and other
objects to, then arrange the objects on
the page however you like.
When you open a page layout
document (or template), there is no
body text area; to add text you need to
This guide helps you to get started using
add a text box and type in it. New pages
Pages 12.1 on your Mac. (To see which
must be added manually.
version of Pages you have, choose Pages >
About Pages from the Pages menu at the
Pages templates are designed for either
top left of your screen.)
word processing or page layout. The way
you add or delete pages, work with
Word-processing and page layout
objects, and more depend on the type of
documents in Pages on Mac
template you choose. If you begin a
Pages is a word-processing and a page
document with one type of template, you
layout app rolled into one. Before you
can convert the document to the other
choose a template to get started,
type. For example, if you like the text
decide which type of document you
styles, colors, and layout of the School
want to create:
Newsletter template, but you want the

design flexibility of a page layout
document, you can convert the
document to page layout.
How to tell which kind of document you’re
viewing
To see whether a template (or document)
is set up for word processing or page
layout, open it. Click the Document tab at
the right of the Format tab in the toolbar
and see if the Document Body checkbox
is selected. If it is, it’s a word-processing
document. If not, it’s a page layout
document.
images, charts, and other objects in Pages
on Mac
An object is any item you place on a page.
Tables, charts, text boxes, shapes, and
photos are examples of objects. Object
types are represented by buttons in the
toolbar. Click these buttons to select
specific objects to add to your document.

You can change the look of an object by
modifying individual attributes of it—like
its fill color, border, shadow, and more—
or you can quickly change the overall
appearance of an object by applying a
predesigned object style to it. Object
styles are combinations of attributes that
are designed to match the template
you’re using.
Continued on next page
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When you select an object, you see
formatting controls for it in the sidebar
on the right. Only the controls for the
type of object you selected are visible. If
you don’t see a sidebar, click in the
toolbar. (Click the button again to hide
the sidebar.)
You can layer objects, resize them, and
control how text flows around them on
the page. For example, you can have text
wrap around an object, or place an
object inline, so that it sits on the same
line as the text and moves with the text
as you type. Some objects can also be
nested inline with the text inside a text
box or shape.
Using templates
A template is a predesigned set of
elements for creating a document—a
layout, placeholder text and images, and
so on. Placeholders give you an idea of
what a document created with this
template might look like when you use its
text and object styles. Every time you
create a new document, you choose a
template from the template chooser as a
starting point.
The template chooser
A sidebar on the left lists template
categories you can click to filter options.
On the right are thumbnails of
predesigned templates arranged in rows
by category, starting with Basic at the top
and followed by Reports and Books—
Portrait. The Language and Region popup menu is in the bottom-left corner and

Cancel and Create buttons are in the
bottom-right corner.

After you open a template, you can add
your own text, replace placeholder
graphics or delete them, and add new
objects (tables, charts, text boxes,
shapes, lines, and media).
To modify text and objects in your
document, you use the formatting and
layout controls in the sidebar on the
right side of the Pages window. The
sidebar shows only controls for the text
or object you selected.
Other sidebars (on the right and left of
the Pages document) have controls to
format your document, review comments
and changes, view page thumbnails to
navigate the document, and more.
You can quickly change the look of a
selected object (image, shape, table, or
chart) by clicking one of the six styles
near the top of the Format sidebar. Use
the other controls in the sidebar to
customize the object however you like.

For more formatting options, click the
tabs at the top of the sidebar.
If you create a document that you want to
use again as a model for other
documents, you can save it as a template.
Creating your own template can be as
simple as adding your company logo to an
existing template, or you can design a
completely new template.
You can add your custom templates to
the template chooser, save them as a file
to share with others, and use them in
Pages on your iPad or iPhone. Custom
templates that you create on your Mac
are grouped in the My Templates
category of the template chooser and are
shared across all your devices.
Click Save as Template in the File menu.
You can name it when you save it, or you
can rename it later in the Chooser by right
clicking the name and choosing “Rename.”
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The Fine Print

YOU ARE INVITED!
Please join us for the monthly
SJAUG Zoom Meeting
Saturday, October 22 at 10 am
The meeting will be in two
40 minute sessions, with a short
intermission between them.
Login Link will be via email invitation
sent to you a few days before the meeting.
The same link will work for both sessions.
You do not need to have
the Zoom app installed on your Mac.

The Candy Apple is e-published
monthly as a PDF file by the South
Jersey Apple Users Group (SJAUG) for
its members and other computer
clubs on an exchange basis. SJAUG is
an all volunteer, no-profit organization
devoted to the exchange of public
domain information, ideas, and the
common interest of Apple product
users and is in no way affiliated with
Apple, Inc. or any other commercial
organization. The views expressed
herein are the sole responsibility of
each author and do not necessarily
represent the views of SJAUG.
The Candy Apple is currently
composed on a 2017 MacBook Air
1.8 GHz Intel Core i5
using mac OS Monterey 12.5.
Programs used to create and layout
the Candy Apple include
these applications:
Pages 12.1, Preview 11.0
Apple TextEdit 1.17.
PDF Expert 3.0.25
Apple, Macintosh, Mac and any other
Apple trademarks
are property of Apple, Inc.

OFFICERS
President .........................Position Open
Vice President.................Al Soderstrom
Treasurer ...............................Karen Ryan
Secretary ...................................Judy Ries

LEADERS
Membership .................Elaine Reichenbach
Program Moderator ............Jerry Mulvaney
AUG Ambassador ................Al Soderstrom
Candy Apple ..........................Carol Sierzega
Website ..................................Carol Sierzega

With breathless awe I draw it in,
Fear to miss one splash of flame
On blackened spire aloft with wisps
Of life drifting down one by one
Until the scene is all but done,

To open yet another scape
Of crystal spark and frosty flake,
Ever changing quickly by
I’ll drink it in until I die.
~ Anonymous

How to Exit Recovery Mode on Mac
OS X DAily

Recovery Mode is typically used for
troubleshooting a Mac, for reinstalling
system software, erasing disks, and
performing similar tasks. Rarely, a Mac
just boots automatically into Recovery
Mode constantly as well. You will be
relieved to know that exiting recovery
mode on a Mac is incredibly simple.

Did You Know?
The first patented roller skates were
introduced in 1760 by Belgian inventor
John Joseph Merlin; his invention closely
resembled modern in-line skates as he
essentially took ice skates and put small
wheels where the blades would go.

When working with a team, Apple iCloud
collaboration makes it easy to keep
everyone current on changes to Pages,
Numbers, and Keynote docs.

What Is a Universal Binary on Mac?
Benj Edwards, Howtogeek.com

To ease the transition into Apple Silicon
Macs, Apple allows developers to create a
Universal Binary, which is an app file that
can run on both older Intel and modern
Apple Silicon Macs. We’ll explain what
they are and how they work.
Did You Know?
New Jersey has the highest population
density in the U.S. an average 1,030
people per sq. mi., which is 13 times the
national average.

OS X Daily

If you’re a Mac user trying to join a wi-fi
network, whether your own, a friend or
family members, or a corporate wireless
network, you can make the process of
joining the wi-fi network much easier by
using the shared wi-fi password feature.

How to play soothing white noise in
macOS Ventura

How To Add Music In iMovie On a Mac

Mac to constantly play from a set of
"white noise" sounds.

You can add music to your iMovie project
from a file, from iMovie itself, or your
Music library. Once in iMovie, you can
adjust it, fade, apply effects and more. But
be careful when adding music to make
sure you take into account copyright.

Roman Loyola, Senior Editor Macworld
How to Collaborate on Pages,
Numbers, Keynote Docs Using iCloud In macOS Ventura, you can now set the
Dennis Sellers, eshop.macsales.com/blog

Get a Shared Wi-Fi Password on Mac

How to Sync Desktop and
Documents Folder to iCloud on Mac

Gary Rosenzweig, MacMost.com

OS X Daily

Understanding Safari AutoFill

Do you want to make sure the files
stored on your Mac’s desktop and in
the documents folder are accessible
from all your Apple devices? You can
set this up pretty easily on your Mac
with the help of iCloud.

Gary Rosenzweig, MacMost.com

How to Restart/Reboot an Apple
Studio Display
Dennis Sellers, eshop.macsales.com/blog

Performing a restart on an Apple Studio
Display can clear up glitches you may
encounter. Here's how to do it.

AutoFill in Safari makes it easy to fill in
fields in forms on web pages with your
name, email address, passwords, credit
card information and other details. You can
use it more effectively if you understand
where the information comes from and why
it sometimes doesn't work as expected.
Did You Know?
The letter “J” is not found anywhere on the
periodic table of elements, in either the
abbreviations or the formal names.
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Did You Know?
The first baseball game was played in
Hoboken New Jersey.

How to Use iCloud Private Relay on a
Mac to avoid Web Trackers

You can take it with you: How to
destroy the data you leave behind

Dennis Sellers, eshop.macsales.com/blog

Glenn Fleishman, Senior Contributor, Macworld.com

Adding Your Pets As People In
Mac Photos

Apple’s iCloud+ adds iCloud Private
Relay, a VPN-like service designed to
prevent anyone from spying on your
Internet traffic.

While many people want to ensure their
email, photos, and other information can
be accessed by families or others after they
die, some want it locked away.

How to stop email read receipts in
Apple Mail

Universal Control and Sidecar: Which
can run on your Mac and iPad?

Glenn Fleishman, Senior Contributor, Macworld.com

Glenn Fleishman, Senior Contributor, Macworld.com

Never implemented as a mail standard,
there’s no good way to find out if
someone read your message.

Apple’s two features that turn an iPad
into an extension of your Mac have a long
list of requirements.

How to Use Reading View in Apple
Pages, Numbers, and Keynote

Scary Zoom flaw allows a hacker to
completely take over your Mac

OS X Daily

Roman Loyola, Senior Editor Macworld

Whether you’re using Apple Pages,
Numbers, or Keynote applications, you may
want to hide the editing tools as you review
a document, and you can do this thanks to
a handy reading view feature available in
each of the Apple iWork suite apps.

Before you log into Zoom to start your
next video call, you should take a few
minutes before you join to update your
app. Here's how to update Zoom before
your next meeting.

Roman Loyola, Senior Editor Macworld

Want to know the word count of a Pages
document you’re working on from the
Mac? We’ll show you how to display the
word count of documents in Pages for Mac.

Photos will easily mark pictures as
containing people's faces, as long as they
are human. But you can also manually
add your pets or anything you like to the
People feature manually.

Parallels Desktop 18 Is Ready for
macOS Ventura
Corbin Davenport, Howtogeek.com

Corel’s Parallels is one of the most popular
apps for running Windows on a Mac,
alongside options like VMware Fusion and
VirtualBox. Parallels Desktop has now
released a new update, but if you don’t
have the all-access subscription, it’s
probably not worth the upgrade fee.

How to Record a Zoom Meeting
OS X Daily

Are you looking for a way to record your
Zoom meetings? Perhaps, you want to
save a recording of a corporate meeting,
or your online lectures for later while
you’re studying, or you’re just trying to
keep a copy of an important meeting?
You’ll be pleased to know that there are
multiple ways to record

How to Show Word Count in Pages
Hacker shows how this macOS flaw can for Mac
be used to access every file on a Mac
OS X Daily
A vulnerability was discovered in macOS's
saved state feature, which automatically
opens the apps and files you have open
when you restart a Mac.
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Which Mouse Is Best for My Mac?
Tim Brookes, Howtogeek.com

Is the Magic Mouse the best choice for
Mac users, or should you spend your
money on a third-party pointing device?
And should MacBook owners bother
“upgrading” from the Magic Trackpad on
their device?

Why Did My Mac Menu Bar
Disappear?
Gary Rosenzweig, MacMost.com

If you notice that the Menu Bar at the top
of your screen is missing, it is probably
because you are using an app in Full
Screen mode. You can customize how
this works in System Preferences. You
can also use Mission Control and Spaces
to have the Menu Bar present for some
apps and not others.

10 Things You Can Do On Your Mac
When Bored
Gary Rosenzweig, MacMost.com

If you are looking for something to do
with your Mac when you have down time,
try one of these ideas that don't involve
browsing the web or using social media.
Did You Know?
Elizabeth, New Jersey has the largest
seaport in the U.S.

Did You Know?
On August 29, 1758 New Jersey
established the first American Indian
Reservation in Shamong Township.

10 Ways To Switch Between
Windows In the Same App On a Mac
Gary Rosenzweig, MacMost.com

If you have several documents or
windows open in the same app there are
many ways to switch between these
windows.

Stop Adobe Background Processes
From Automatically Launching
Gary Rosenzweig, MacMost.com

If you have Adobe Creative Cloud
installed then every time you start your
Mac the Creative Cloud app and a
number of big background processes will
start automatically. If you don't use
Adobe apps every day, you may want to
change this so none of it starts until you
use your first Adobe app.

25 Things You Can Do With
QuickTime Player

Shift+Enter Is a Secret Shortcut
Everyone Should Know
Benj Edwards, Howtogeek.com

The Enter key can mean several things
based on context. It can produce a line
feed and carriage return, or it can
submit a form or text field. With
Shift+Enter, you can often toggle
between those two modes with ease.
Here’s why—and how to use it.

How to adjust the date and time in
the macOS Menu Bar
Glenn Fleishman, Senior Contributor, Macworld.com

Apple likes to reorganize where you
find things. Date & Time settings oddly
don’t include how the date and time
appear in macOS.

How to Split Screen on Mac
OS X Daily

Using Split Screen on a Mac is easier than
ever before in the latest versions of
MacOS, including macOS Monterey, Big
Sur, and Catalina.

Gary Rosenzweig, MacMost.com

How to find, delete, and manage WiFi network passwords on macOS

QUickTime Player is a lot more than just
a simple video playback app. You can
record video too, record and play audio,
do some basic editing, grab frames,
combine images and much more.

Apple stashes passwords entered to
connect to Wi-Fi networks in the
safest place possible: the systemwide login keychain.

Glenn Fleishman, Senior Contributor, Macworld.com
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The Fastest Ways to Resize and
Convert Images on Mac
Tim Brookes, Howtogeek.com

Your Mac comes with some powerful tools
to make resizing and converting images fast
and convenient. These include workflow
tools like Automator and Shortcuts and
Apple’s basic image viewer Preview.

How to Keep the Mac Dock on One
Screen in a Dual Monitor Setup
Dennis Sellers, eshop.macsales.com/blog

After attaching an Apple Studio Display
to my 16-inch MacBook Pro, I found that
the Dock wouldn’t stay in place. There’s
no great solution, but there are a couple
of workarounds.

How to Change Your Facebook
Password
Harry Guinness, Justin Duino, and Nick Lewis
Howtogeek.com

Most people use terrible passwords. If
you’re one of them, you should change
all your important passwords to
something a lot more secure — and
believe it or not, that includes Facebook.
Did You Know?
The brand name of Leatherman multitools
and knives isn’t just a manly trademark, it’s
actually the name of one of the company’s
cofounders, Timothy S. Leatherman.

Trivia
The Only Variety Of Apples Native To
North America Are?
(Click on your answer choice)

• Granny Smith
• Honeycrisp

• Crab Apples
• Gala

How to configure shutdown settings
with a UPS on a Mac
Glenn Fleishman, Senior Contributor, Macworld.com

Plugging most uninterruptible power
supplies (UPS) into a desktop Mac
enables a menu of options for dealing
with power outages.

How to Unsubscribe from Public
Calendars on iPhone, iPad, & Mac
OS X Daily

If you change your mind and you no longer
wish to see these calendar events, you’ll
need to unsubscribe from the calendar.

Should You Run Your Laptop With
the Lid Closed?
Sydney Butler, Howtogeek.com

You may want to run your laptop with its
lid closed to save space. However, your
laptop wasn’t designed to run full-tilt
with a closed lid, right?

How to Properly Clean Your Gross
Laptop
Andrew Heinzman, reviewgeek.com

Like any computer, laptops are dust and
grime magnets. But a dirty laptop isn’t
just a cosmetic nightmare—it can also
cause poor performance and
overheating. So, how can you clean your
laptop properly?

8 Reasons You Should Be Using Safari
on Your Mac
Tim Brookes, Howtogeek.com

Safari comes pre-installed on your Mac and
might just be all you need from a web
browser. It also has some features that make
it a more attractive and convenient option
for owners of Apple hardware in general.

Apple's Self Service Repair program
comes to MacBooks
Jason Cross, Staff Writer Macworld

Users will be able to buy genuine Apple parts
and buy or rent tools beginning August 23.

The Best Way To Completely
Uninstall Mac Apps
Jeff Greenberg, eshop.macsales.com/blog

The Apple way of deleting applications leaves
residue—parts of the installation and other
miscellaneous files will remain on your
system. Here's how to completely delete apps.
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How To Use Mac Reminders In 5
Minutes

Unable to Auto Unlock Mac with
Apple Watch? Troubleshoot & Fix

Customizing the Mac Context Menu

Gary Rosenzweig, MacMost.com

OS X Daily

If you haven't been using the Reminders
app on your Mac and other Apple devices
you are missing out on a very useful tool.
Learn the basics in just 5 minutes with
this quick tutorial.

Apple allows users to unlock their Macs
using their Apple Watch, which is a super
handy feature for users of both devices.
As convenient as this may sound, the
feature isn’t completely flawless though,
and sometimes you may run into issues
with the auto-unlocking Mac feature.

The context menu appears when you
Control+click, right+click, or two-finger
click something on a Mac. Most of the items
in a context menu appear depending on
what was clicked and which app you are
using. But some parts of the context menu
can be customized to fit your needs.

10 Ways To Quickly Get To Folders
When Saving Files
Gary Rosenzweig, MacMost.com

When you go to save a file it can be
frustrating to find the location you want. But
there are many things you can do to quickly
navigate to your folders in the Save Dialog.

Better Than Multiple Selections In Pages
Gary Rosenzweig, MacMost.com

You Can't Select Multiple Non-Contiguous
Portions Of Text In Mac Pages. But Most Of
The Time People Want To Do This It Is To
Apply A Style On Those Portions Of Text.
Learn How To Do This More Efficiently Using
Character Styles In Pages.

5 Reasons Finder List View Is The Best
Gary Rosenzweig, MacMost.com

You have four choices when it comes to
Finder views List View, however, has
several advantages which make it my goto Finder view.

Did You Know?
Rats, mice, and other rodents communicate
not just in the range of sound frequencies
humans can hear (approximately
20-20,000 Hz), but in ultrasonic
frequencies as high as 91,000 Hz.

You Probably Don’t Need Adobe
Reader On Your Mac
Gary Rosenzweig, MacMost.com

Many Mac users have Adobe Reader
on their Macs so they can read and fill
out PDF files. But macOS already has a
very capable PDF app named Preview.
Most people will find it more than
capable for all of their needs, and
perhaps a little faster and convenient.
If Adobe Reader is set as your default
PDF app, I'll show you how to switch
back to using Preview.

Gary Rosenzweig, MacMost.com

Think You Have Duplicate Files Or
Photos? Maybe Not.
Gary Rosenzweig, MacMost.com

Often people ask me about duplicate
photos or files when all they are seeing
is two different ways of viewing the same
single photo or file. For instance, albums
in Photos show the same photos as the
Library, and Recents and the Desktop in
the Finder show files you can also see
elsewhere. It is important to understand
why these aren't duplicate items to
avoid deleting the one and only copy of
a photo or file.

How to block Safari from asking to
open a bookmark file every time it
launches
Glenn Fleishman, Senior Contributor, Macworld.com

A setting that opens favorite items in
your bookmarks causes a recurring
glitch. Here’s a simple solution that may
have eluded you—it’s obscure.
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Did You Know?
If you eat a diet rich in vegetables, then
you’re eating a wide variety of plant parts.
For example, when we eat asparagus we’re
eating the stem of the plant, with carrots
we eat the root, with corn we eat the seeds,
with lettuce we eat the leaves, and with
broccoli we eat the flower.

How to translate text on a photo
on iPhone

How to Enable Night Shift On Your
iPhone for Easy Nighttime Reading

Martyn Casserly, Contributor, Macworld

Jason Fitzpatrick, lifesavvy.com

Use Live Text in iOS 15 to translate text in
photos on your iPhone from one
language to another.

Bright blue-white light blasting in your
face at night isn’t so great for your sleep
or general health, but don’t worry; iOS
supports color shifting so you can warm
up the light of your iPhone for easy
nighttime reading.

What Is Downtime on iPhone, and
How Do You Turn It Off?

Most iPhones Will Get Battery
Joe Fedewa, Howtogeek.com
Percentages in the Status Bar in iOS 16 The iPhone and iPad include several
Corbin Davenport, Howtogeek.com

Apple is working on this year’s big iOS 16
update, which is expected to roll out to all
(supported) iPhones within the next few
months. The latest beta added a small,
but helpful, improvement.

10 Great iPhone Features You Should
Be Using
Benj Edwards, Howtogeek.com

There’s a lot to love about the iPhone,
and it can be overwhelming at times.
Apple’s smartphone includes thousands
of handy features tucked away in places
you might never discover unless
someone told you about them.

The price of the iPhone 14 is going
up–but will it be worth it?
Martyn Casserly, Contributor, Macworld

With iPhone prices set to increase, we
look at what's causing the spike.

tools to help you create healthy usage
habits. “Downtime” is one the most
powerful and lesser known of the bunch.
We’ll explain why you should use it and
how to remove it if it’s enabled.

Apple’s Old 5W iPhone Charger Is
Going Away: Here’s Why
Corbin Davenport, Howtogeek.com

Remember the tiny USB wall charger that
used to ship with old iPhones, iPads, and
even some iPods? Apple still sells the
power adapter, but it seemingly won’t for
much longer.

Can a Magnet Really Damage My
Phone or Computer?
Jason Fitzpatrick, lifesavvy.com

There’s a long-standing belief that
magnets are dangerous to have around
electronics, but can they really damage
your phone or computer?

Your Phone Plan Might Add iCloud,
Apple Music, and More
Corbin Davenport, Howtogeek.com

It’s common for cell phone plans to
bundle streaming services or cloud
storage, usually at a reduced cost or free.
Apple has now opened the door for
iCloud storage, Apple Music, Apple TV+,
and other services to be bundled with
mobile carrier plans.

iPhone VPN apps are ‘a scam,’ security
researcher warns–and Apple knows it
Karen Haslam, Editor, Macworld

Michael Horowitz claims that VPNs on
iOS aren't protecting your data like they
claim and Apple has know for years.
Did You Know?
North Jersey has the most shopping malls
in one area in the world with seven major
shopping malls in a 25 sq. mile radius.
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How to Find Word Count for Pages
Documents on iPhone & iPad

How to Stop Apps From Tracking
Your Precise Location on iPhone

OS X Daily

Khamosh Pathak, howtogeek.com

Need to know the word count of a
document you’re working on in Pages?
Word counts can help you determine
how long something that you’re writing,
whether for school, work, or personal.

When a ride-sharing app asks you for your
location, it’s for a good reason. But some
apps needlessly request your location for
doing menial tasks. Here’s how you can
stop those apps from tracking your
precise location on your iPhone.

How to Access Reader Mode in Safari
Smartphones Need More Physical
on iPhone & iPad
Buttons
OS X Daily
Reader Mode in Safari is a fantastic
feature for Safari on iPhone and iPad that
lets you more easily read just about any
web page, and works particularly great on
longer articles or pages with a lot of
clutter. Basically Reader mode will strip
away any and all other page content
except for the article text, so whatever
you’re reading is very clearly the focus,
without any distractions.

Remove Dictation Button from Safari
Address Bar on iPhone & iPad
OS X Daily

When the microphone icon is tapped
Many users may accidentally tap on the
microphone dictation button in Safari on
iPhone or iPad, and thus may want to
disable and remove the dictation button
from Safari on their device.

Joe Fedewa, Howtogeek.com

Smartphone design has changed a lot
over the years. Slide-out keyboards and
headphone jacks have been discarded for
sleek, slim designs. We’ve also seen the
number of buttons get chopped down,
and I think that needs to change.

How to Change the Font of a
Webpage in Safari on iPhone & iPad
OS X Daily

In this article, we’ll show you how to
change the font of a webpage in Safari on
both the iPhone and iPad without having
to use a third-party web browser.
Did You Know?
New Jersey has the most diners in the
world and is sometimes referred to as
the diner capital of the world.

Did You Know?
Despite the popular belief that dogs only
see in black and white, it’s untrue. While
dogs may not see the same range of color
that humans do, they do perceive colors
on par with a human suffering from redgreen color blindness.

9 Smartphone Battery Myths You
Should Stop Believing
Jason Fitzpatrick, lifesavvy.com

Smartphones are a ubiquitous part of our
lives now, and so are the numerous
myths about how to eke out more life
from your smartphone battery.

Got an older iPhone or iPad? Get iOS
12.5.6 today
Jason Cross, Staff Writer Macworld

This release features a critical WebKit
security update, so you should update
right away.

iOS 12.5.6 Update Released for
Older iPhones & iPads with
Important Security Fix
OS X Daily

Apple has issued an important security
update to older model iPhones and iPads
that are not able to run the latest iOS 15
operating system. iOS 12.5.6 includes
important security patches.
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Did You Know?
The Nintendo company was founded in
1889 to produce playing cards and, to
this day, despite significantly larger
holdings in the video game industry, still
produces playing cards.

10 Awesome iPad Features You
Should Be Using
Benj Edwards, Howtogeek.com

Can You Split Screen on iPhone?
Mahesh Makvana, Howtogeek.com

Splitting your screen can make
multitasking a cinch, allowing you to use
apps side-by-side without having to
constantly switch between them. It’s easy
to do on most PCs, Macs, the iPad, and
How to Force Restart an iPhone 11
even on Android. But what about iPhone? Mahesh Makvana, Howtogeek.com
How to turn off and force-restart
Force restarting your iPhone 11 is a good
way to fix various system issues,
your iPhone
unresponsive behavior, and other app
Jason Cross, Staff Writer Macworld
problems. You don’t lose your data when
Have you tried turning it off and then on
again? If you suspect some bug has made you do this, and we’ll show you how to
perform the process on your phone.
your phone unresponsive or slow, the

Whether you’re an iPad veteran or
newbie, Apple’s tablet packs so many
features that some of them might have
slipped under your radar. Let’s take a look first troubleshooting step should be that
at ten great features that every iPad
old IT standby: turn it off and on again.
owner should use.

How to Take Photos of Space With
How to Hard Lock an iPhone to Prevent Your Phone
Unauthorized Biometric Access
Joe Fedewa, Howtogeek.com
OS X Daily

If you’re ever in a situation where you are
concerned about unauthorized biometric
access to your iPhone, for example,
someone holding your iPhone up to your
face to unlock it with Face ID, or someone
forcing you to put your finger on the
Touch ID sensor to unlock the iPhone,
you can prevent that unauthorized access
to the iPhone with a Hard Lock trick.

Did You Know?
When glass cracks it seems almost
instantaneous thanks to the speed at which
glass shatters–cracks form in glass at a
staggering 3200 meters per second.

Smartphone cameras have come a long
way since the early days. You can take
pretty good photos in low light now, but
what about the ultimate low-light
condition—space? Astrophotography is
possible if you know a few tricks.
Did You Know?
The honeybee, apis mellifera, is the
New Jersey state bug, designated as
such in 1974.

How to use the new Passkeys on your
iPhone, iPad, and Mac

Glenn Fleishman, Senior Contributor, Macworld.com

Apple’s version of an industry-standard
website login requires a little effort to set
up and then almost none to use.

How to Add Apple AirPods to Find
My on iPhone
Mahesh Makvana, Howtogeek.com

If you’d like to track your AirPods’
location when you lose them or when you
can’t find them, add your AirPods to
Apple’s Find My feature. You can then
use your iPhone as well as the iCloud
website to find your AirPods’
whereabouts. Here’s how to do that.
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Did You Know?
Thorny dragons, a species of small
lizard native to Australia, appear to be
able to drink from their feet, but in
reality their ridged scales can move
water via capillary action towards the
lizard’s mouth, allowing it to “drink” by
putting its limbs against a water source.

What Is an LED?
Benj Edwards, Howtogeek.com

You can’t go anywhere these days
without hearing about LEDs, whether in
TV sets, light bulbs, smartphones, or
otherwise. But what are they, and how
are they different from other light
sources? We’ll explain.

How to Restart an Apple TV
Benj Edwards, Howtogeek.com

If you’re having trouble with your Apple
TV—if it has become unresponsive or
buggy, for example—it’s a good idea to
completely restart the device itself, which
can fix many issues. Here’s how to do it.

What Is a Pixel?
Benj Edwards, Howtogeek.com

In our age of digital media, we often take
for granted the humble pixel. But what
exactly is a pixel, and how did it come to
be such an important part of our lives?
We’ll explain.

How to See How Much Money You’ve Roku Now Has More Free Built-in
Spent on Amazon
Local News Channels
Jason Fitzpatrick, lifesavvy.com

Corbin Davenport, Howtogeek.com

Most of us have spent quite a bit of
money on Amazon over the years,
especially during the pandemic. If you’re
curious exactly how much money you’ve
ever spent on your Amazon account,
there’s a way to check the total.

Roku-powered TVs and streaming devices
already have the Roku Channel, which
has free movies, TV shows, and some live
content. The Roku Channel started
adding local news channels in June, and
now more have arrived.

Did You Know?
The first drive-In movie theatre was
opened on June 6th, 1933 on Admiral
Wilson Blvd. in Camden NJ.

Can I Reuse My Old Wi-Fi Name and
Password on My New Router?
Jason Fitzpatrick, lifesavvy.com

Buying a new Wi-FI router doesn’t have
to mean going through a tedious setup
process on all your current Wi-Fi devices.
Here’s what you need to know about
reusing your Wi-Fi name and password.

What Ever Happened to Plasma TVs?
Gaurav Shukla, Howtogeek.com

Once regarded for their picture quality,
plasma TVs no longer have a place in the
market. But what led to the
disappearance of this TV technology?
And if you’re looking for a plasma TV
replacement, what should you get?

8 Common PayPal Scams and How to
Avoid Them
Tim Brookes, Howtogeek.com

PayPal’s widespread adoption means it’s
popular with scammers looking for a
victim. Though these scams aren’t
necessarily exclusive to PayPal, they
flourish in the service due to its ease of
use and preference among online sellers

7 Ways to Curb Laptop Fan Noise
Sydney Butler, Howtogeek.com

Whether gaming, browsing the web, or
doing serious work, there’s a laptop with
enough processing muscle to handle
almost anything. Unfortunately, it may
get very loud while doing it. But there are
ways to curb that noise.
Did You Know?
Cape May holds the distinction of being
the oldest seashore resort in the United
States and one of the most unique.
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What is VGA?
Benj Edwards, Howtogeek.com

You’ve probably seen a VGA video
connector on the back of a TV set, video
projector, or even on a computer. We’ll
explain what it is, where it came from,
and help you decide if you should use it.

Microsoft Edge Is Now More Bloated
Than Google Chrome
Joe Fedewa, Howtogeek.com

People love to rag on Google Chrome for
being a bloated browser that eats up your
computer’s resources. Well, Microsoft
Edge has become even worse. It started
out with good intentions, but Microsoft
can’t help itself.

Chrome Will Revamp Its Forgotten
App Menu, to Match Edge
Corbin Davenport, Howtogeek.com

Google Chrome has been able to save sites
as app shortcuts for years, but the built-in
Apps page hasn’t been updated or
improved in years. That might change soon.

Why Is Everything a Subscription Now?
Benj Edwards, Howtogeek.com

From streaming services to software to
content, it feels like we’re constantly
shelling out money every month to keep
access to the things we want. So what’s

Trivia
Who originally spread the idea that
carrots improve night vision?
(Click on your answer choice)

• The U.S. Department of Health
• Saturday Night Live
• American Carrot Farmers
• The British Government

How to Safely Pack and Ship Fragile
Electronics
Benj Edwards, Howtogeek.com

If you need to ship something bulky or fragile,
such as a computer case, CRT monitor,
priceless video game retail box, stereo
component, or otherwise, it can be tricky to
protect it from damage. We’ll show you how.

Headphone Impedance and
Sensitivity Explained
Kris Wouk, Howtogeek.com

behind this shift, and is there anything
you can do about it?

8 Apple 'Pro' products that are
coming to drain your wallet
Michael Simon, Executive Editor Macworld

Apple has a bunch of new products in the
pipeline. You'd better start saving now.

How to Hide WhatsApp Last Seen
Status from Specific People
OS X Daily

By default, WhatsApp will show a ‘Last
Seen’ status of contacts, which lets you
know when the user was last using
WhatsApp. The latest versions of
WhatsApp allow you to selectively hide
the Last Seen status from specific people
or contacts.

Sensitivity and impedance are both
important factors for headphones, but
they can be tough to understand. We’ll
take a look at both and show you why
they’re important and how to use that
knowledge while headphone shopping.

LibreOffice, the Free Office Suite,
Just Got a Big Update
Corbin Davenport, Howtogeek.com

LibreOffice is a popular free and opensource office suite, with free alternatives to
Microsoft Word, Excel, and PowerPoint.
LibreOffice 7.4 was just released, and it
has a few great new features.
Did You Know?
The light bulb, phonograph, motion
picture projector were invented by
Thomas Edison in his Menlo Park NJ
laboratory.
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How to Recover an Unsaved
Microsoft Office File

What Happens When an Electric
Vehicle Battery Dies?

Walter Glenn Howtogeek.com

Cory Gunther, Howtogeek.com

You’ve just closed an Office document
and accidentally clicked Don’t Save Or
maybe Word crashed or your laptop lost
power before you remembered to save
what you were working on. We’ve all felt
that pain, but all is not necessarily lost. By
default, Office applications automatically
save temporary backup copies of your
documents as you work and there’s a
good chance you can recover them.

With the rise of electric vehicles, new and
potential owners have many questions. If
you are wondering what happens when
the battery dies, you’re not alone.

Why Was Atari Called Atari?

California Says EV Batteries Have to
Last Longer
Corbin Davenport, Howtogeek.com

“It’s actually electric. The only bad thing is you can
only go 50 feet before you have to charge it again.”

Benj Edwards, Howtogeek.com

With powerful branding and design, Atari
became a household name in video games
and computers during the 1970s and early
’80s. We’ll explain how its founders came
up with the name and what it means.

How to Identify and Measure
Phantom Loads in Your Home
Jason Fitzpatrick, lifesavvy.com

Who wants to pay more on their electric
bill if they don’t have to? Here’s how to
identify and measure phantom loads to
save money.
Did You Know?
After exposure to factory waste, french
bees were found producing green honey.

Where Did the Term “Computer
User” Come From?
Benj Edwards, Howtogeek.com

We use the term “computer user”
frequently, but with so many people who
purchase computers, why not say
“computer owner,” “computer customer,”
or something else? We dug into the
history behind the term and found
something we never expected.

5 reasons to stop using Safari and
switch to another Mac browser
Chris Barylick, Macworld

Chrome, Firefox, DuckDuckGo, Brave:
You have choices other than Safari.

The most vital component of any electric car
is the battery, and the battery’s health can
significantly impact the car’s range and
value. The U.S. state of California is now
laying out rules for the batteries used in EVs.

How Much Energy Are Your
Streaming Media Players Using?
Joe Fedewa, Howtogeek.com

Streaming TV devices—such as a Roku or
a Chromecast—are plugged in and always
ready. When your TV turns off, it uses
less power, but what about the streaming
devices? How much energy do they use?

Should You Turn Up the Transmit
Power on Your Wi-Fi Router?
Jason Fitzpatrick, lifesavvy.com

If you’re struggling to get good Wi-Fi
coverage in your home, it would seem
intuitive to turn up the transmit power of
your Wi-Fi router. Before you do, read this.
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What Happened to Solar Laptops?
Sydney Butler, Howtogeek.com

What if you could use your laptop’s
battery without ever needing to plug in,
relying totally on the sun’s rays instead of
a bulky, tangling power cord? Solar
laptops existed in the past, but they
didn’t catch on. So what happened?

Can I Reuse My Old Wi-Fi Name and
Password on My New Router?

Did You Know?
Your hike through the grocery store to
get to basic staples like sugar and flour
isn’t accidental. Modern grocery store
layouts are designed so that shoppers
have to walk past more profitable
products before reaching staple items at
the back and outer aisles of the store.

What to Do With Your
Old Phone Cases

Jason Fitzpatrick, lifesavvy.com

Joe Fedewa, Howtogeek.com

Buying a new Wi-FI router doesn’t have
to mean going through a tedious setup
process on all your current Wi-Fi devices.
Here’s what you need to know about
reusing your Wi-Fi name and password.

If you have a phone, there’s a good chance
you have a case on it. That means you
probably also have some old cases lying
around, even if you don’t have the phone
anymore. What can you do with them?

How to use Apple TV to access
photos on a Mac

Will a Smart Thermostat Actually
Save You Money?

Glenn Fleishman, Senior Contributor, Macworld.com

Jason Fitzpatrick, lifesavvy.com

The process for setting up photo sharing to
an Apple TV remains obscure. Here’s how.

There are a greater number of smart
thermostats on the market than ever before,
and one of the selling points is that they will
save you money. But will they? Here are
some key things to consider.

These 5 Popular Chrome Extensions
Are Malware: Delete Them Now
Corbin Davenport, Howtogeek.com

Google Chrome extensions can supercharge your browsing experience with more
features, but there have been many
malicious extensions over the years. Five
more bad extensions have been discovered,
thanks to a recent security report.

Did You Know?
Babies seem to have such large eyes because
humans are born with eyes approximately 75
percent of their adult size; the remaining 25
percent of growth occurs slowly between
birth and the end of adolescence.

What Can a UPS Battery Backup
Power?
Haroun Adamu, Howtogeek.com

A power outage can be a tech
nightmare. It may cause you to lose
important work and unsaved game
progress and leave you unable to use
the Wi-Fi for what might seem like ages
—a UPS can easily mitigate this. But
what devices can you actually plug
into a UPS?

How (and Why) to Use DuckDuckGo’s
@Duck.com Email Protection
Tim Brookes, Howtogeek.com

DuckDuckGo is the Google alternative
that offers better privacy protection
than other search engines. After a trial
period the @Duck.com Email
Protection service is now available for
everyone to use, so here’s what it does
and how to use it.

10 Google Maps Features You Should
Be Using
Joe Fedewa, Howtogeek.com

Google Maps is not only one of the
company’s best products, it’s one of the
best products in the internet age in
general. Maps has tons of features you
might not be familiar with. We’ll share
some of the best.
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Why You Shouldn’t Connect to a VPN What Does an Air Purifier Do, and
on Your Router
How Do They Work?
Fergus O’Sullivan, Howtogeek.com

Gaurav Shukla, Howtogeek.com

VPNs are great privacy tools, and connecting
to one on your router means that your whole
network is protected without any extra steps.
However, doing so comes with a number of
drawbacks that may make you think twice
before setting it up.

Air purifiers are gaining popularity over
concerns about indoor air quality. The best
air purifiers claim to get rid of harmful
pollutants and allergens. But can they
actually do that? If so, then how? We answer
all your questions.

Belt Drive vs. Direct Drive Turntables:
Which Is Best for You?

How to Connect an Apple Pencil
to an iPad

Kris Wouk, Howtogeek.com

Sandy Writtenhouse, Howtogeek.com

Whether you’re new to vinyl or looking to
upgrade your current setup, you should be
aware that there are two main types of
turntable: belt drive and direct drive. What’s
the difference? Is one better than the other?
We’ve got everything you need to know.

If you just picked up an Apple Pencil and
want to use it with your iPad, you’ll need to
connect the devices first. The method for
pairing an Apple Pencil to an iPad is different
depending on which Pencil you own.

What Is a “PC,” Anyway?

10 Things You Should Think Twice
About Buying Online

Sydney Butler, Howtogeek.com

Tim Brookes, howtogeek.com

Everyone knows that “PC” is short for
“Personal Computer,” but not everyone can
agree on what counts as a PC or doesn’t. It
turns out that the term “PC” is packed with
more nuance than you might have thought!

Online shopping has revolutionized
retail, mostly for the better, but some
purchases require more care and
attention than others. Make sure you do
your due diligence when buying online
before you fall for a fake or a scam.
The most important thing to remember
when buying anything online is that if it
looks too good to be true, it probably is.

Did You Know?
The Simpsons, got its start as a series of
animated shorts on The Tracey Ullman
Show in 1987.

Did You Know?
The names “buffalo” and “bison” might be
used interchangeably for the large herd
animals found in the American Midwest, but
the correct name is bison as buffalo are a
separate species found only in Africa and Asia.

How to Charge an Electric Vehicle
For Free
Cory Gunther, Howtogeek.com

Drivers making the switch to an electric
vehicle have all sorts of questions, and most
of those revolve around charging times and
cost. But did you know there are ways you
can charge an electric vehicle for free?

Brushing Scams: Here’s Why You’re
Getting Random Packages
Jason Fitzpatrick, lifesavvy.com

Across the United States and other
countries, millions of people are
surprised to receive packages they never
ordered. In most cases, the source is a
scam called “brushing.” Here’s why
you’re getting free loot.

How to remove or change the phone
number linked to your Apple ID
Glenn Fleishman, Senior Contributor, Macworld.com

You might have a number that should no
longer be associated with two-factor
authentication on your account. Here's
how to remove it.
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15 Ways to Solve Call Failures on
Your iPhone
Sure, we know that phone calls aren’t the
most common thing people do on their
iPhones—especially anyone under 30—
but it’s still important to be able to make
and take calls. There are a wide variety of
reasons that outgoing or incoming calls
might fail, so the solutions vary equally as
widely. Some may seem a little
scattershot, but most are easy to try and
set back if they don’t help.
1. Try another location: This can’t
come as news, but sometimes you’re
in a bad spot for cellular coverage.
This is especially true in Vermont
where the mountains get in the way
of the line-of-site cell towers Move to
another area and try again.
2. Check Do Not Disturb in Focus: The
Focus feature won’t prevent you
from making
a call but
can prevent
you from
receiving
one. Go to
Settings >
Focus > Do
Not Disturb
and make
sure Do Not

Disturb is off. Also, check any other
Focus you created that could be
blocking calls.
3. Toggle Airplane mode: Although the
Phone app should alert you if you try
to make a call while in Airplane mode,
the entire point of the feature is to
block cellular access. If Airplane mode
is on, turn it off, and if it’s off, turn it on
briefly and back off to reset the
iPhone’s radios. Note that the Wi-Fi
Calling feature may let you make a call
even if Airplane mode is on. Toggling
Airplane mode is a fix for numerous
cellular and bluetooth issues.

4. Turn off Silence Unknown Callers:
This feature can be a boon for
avoiding telemarketers and spam
calls, but it also prevents legitimate
unknown calls from ringing through.
Either turn it off in Settings > Phone

or pay more attention to adding new
numbers to Contacts.
5. Unblock the
contact: In
theory, you
should still be
able to place
calls to blocked
numbers, but
incoming calls
from blocked
numbers will be
sent directly to voicemail. Look for
blocked contacts in Settings > Phone
> Blocked Contacts and swipe left on
a contact to unblock it.
6. Disable call forwarding: Needless to
say, if you’re forwarding your calls,
you won’t be receiving them. Go to
Settings >
Phone > Call
Forwarding
and make
sure the
switch is off.
7. Toggle Dial Assist: The Dial Assist
feature determines the correct
international or local prefix when
dialing, so if it gets confused, all bets
are off. It can’t hurt to go to Settings
> Phone, turn off Dial Assist, make a
call, and then turn it back on again.
Continued on next page
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8. Show Caller ID: Some phone
systems refuse to accept calls that
aren’t associated with caller ID
information. Check that Show Caller
ID is turned on in Settings > Phone >
Show My Caller ID.

9. Check for a carrier settings update:
Carrier updates are always worth
installing because they can improve
network connectivity and performance
and add new features like 5G or Wi-Fi
Calling. If you dismiss a carrier update
installation notification, you can install
it later by going to Settings > General
> About and following the onscreen
instructions.
10.Restart the iPhone: When in doubt…
We know it’s a cliché, but restarting
the iPhone really does solve many
inexplicable problems. The easiest
way to do this is to go to Settings >
General > Shut Down (at the
bottom) and then drag the slider.
Press the side (Sleep/Wake) button
on the iPhone to turn it on. Actually,
I would move this suggestion to like
number 3 or 4.

11.Update iOS: It’s very unlikely that an
iOS version would have a bug that
caused problems with phone calls,
but updating iOS creates enough of a
clean slate that it can resolve quirky
problems. Besides, it’s good to stay
up-to-date for security reasons. Look
in Settings > General > Software
Update for any available updates.
12.Reset network settings: Leave this
option for late in the troubleshooting
process because it will erase your
saved Wi-Fi passwords, preferred
networks, and VPN settings, which
will be annoying to recreate. If it
becomes necessary, invoke it in
Settings > General > Transfer or
Reset iPhone > Reset > Reset
Network Settings.

13.Eject and reinsert SIM card: If all
outgoing and incoming calls fail, it’s
worth using a paperclip or SIM
extraction tool to pop your SIM card
out and reinsert it. Be very careful
when doing this because the card is
small and easily dropped.
14.Contact your carrier: If all else fails,
contact your carrier. (Yes, we see the
irony here—you may have to use
another phone.) There may be a
problem with your account, a service
outage in your area, or some other
problem in their system. You might
even need a new SIM card.
15.Contact Apple support: If none of
these work, your iPhone could be
broken and need repair. Contact
Apple support and see what they say
—a replacement iPhone will almost
certainly fix the problem.
We’re confident that something on this
list will resolve your problem!

What’s That Little Orange Dot by
Control Center in macOS 12 Monterey?
Have you noticed a little orange dot next
to the icon for Control Center on the
menu bar in macOS 12 Monterey? (And if
not, you can’t miss it now.) Apple added
that dot to alert you that something is
using the Mac’s microphone to listen to
Continued on next page
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the room. Click the Control Center icon to
see which apps are using the mic. In
nearly all situations, it will be entirely
innocuous: Siri needs to listen for the
“Hey, Siri” trigger, as in the screenshot
below, and the Zoom app needs
microphone access to provide audio in a
video call. But if you don’t recognize the
app that’s listening, you’ll want to look
into it to make sure there’s nothing
creepy going on.

Go Beyond Get Info with the Finder’s
Inspector Window
You probably know that selecting a file in
the Finder and choosing File > Get Info
(Command-I) brings up the Get Info
window. This window provides
information about the file, including its

name, kind, size, creation and
modification dates, and much more. You
can also use Get Info to hide or show
filename extensions, lock and unlock files,
and change permissions. But what if you
want to do those things to multiple files or
figure out how large a set of files is? Turn
to the Finder’s Inspector window instead.
Select multiple files, hold down the Option
key, and choose File > Show Inspector
(Command-Option-I). The Inspector
window looks and works almost exactly
like the Get Info window. As a bonus, if
you leave the Inspector window open, it
updates to reflect whatever you select in
the Finder—that’s faster than opening Get
Info repeatedly for different items.

iCloud, Google Calendar, Microsoft
Exchange: Choosing a Personal
Calendar Service

As Mac, iPhone, and iPad users we have
an embarrassment of riches when it
comes to calendaring flexibility. Apple
provides free calendar services via
iCloud, and the Calendar app lets you
add calendar accounts from a wide
variety of providers. Most notable among
them are Microsoft Exchange and Google
Calendar, which are commonly used in
the business world.

Since you can add multiple calendar
accounts to the Calendar app, there’s no
problem bringing your entire scheduling
life together, even if your work uses
Exchange and your kid’s school uses
Google. But which service should you use
for your primary personal calendars,
which you likely need to share with your
immediate family to ensure everyone is
on the same scheduling page? There’s no
one answer, but here’s our take.
Continued on next page
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Start by considering the platforms used by
the people with whom you share calendars
Although it’s easy to share iCloud calendars
with other Apple users, sharing an iCloud
calendar outside the Apple ecosystem
requires making it a read-only public
calendar, which may not be appropriate for
usability and privacy reasons. You can work
around this limitation in different ways,
depending on the platforms in play:
• All Apple: If you and your family all use
Apple devices, the answer is easy—stick with
iCloud calendars. You can easily invite
people to your shared calendars, and
everyone can both see and edit events on
those calendars using a Mac, iPhone, or iPad.
• Apple and Google: What if your child’s
only computing device is a school
Chromebook or your spouse relies on an
Android phone? In such a scenario,
centralize your personal calendars on
Google Calendar, where calendars can be
shared read/write. If you don’t already
have a free Google account, make one, log
in to Google Calendar, and create and
share the calendars from there.
• Apple and Windows: Perhaps a member
of your family relies on a Windows laptop.
If that person installs iCloud for Windows,
they can access iCloud calendars shared
with their iCloud account. (Anyone can
sign up for a free iCloud account, even if
they don’t have an Apple device.)

• Apple, Google, and Windows: Going for
the trifecta, what if different members of
your family rely on Apple devices,
Android phones, and Windows PCs? The
compromise option here is to fall back
on Google Calendar, since both Apple
devices and Windows PCs can access
calendars shared from Google Calendar.
That’s the overview. Briefly, here’s how
you share those calendars in iCloud and
Google Calendar.
Sharing to iCloud Calendars
To share an iCloud calendar, open the
Calendar app on your Mac. Control-click
the calendar
you want to
share, and
choose Share
Calendar. In
the Share
With field of
the dialog
that appears,
start typing the
name of the
person with
whom you want
to share, select
their iCloud
account from
the suggestions,
and click Done
to send the invite.

Subscribing to a shared iCloud calendar
is usually just a matter of clicking a link in
an email, giving the calendar a name, and
adding it to your iCloud account.
Sharing Google Calendars
To share a Google calendar, visit
calendar.google.com in a Web browser.
Hover the
pointer over a
calendar name
in the sidebar,
click the
stacked dot
button that
appears, and
choose
Settings and
Sharing. In
the Settings
screen,
scroll down
to Share
With Specific People, click Add People, and
enter enough of someone’s name that you
can select their email address. Then adjust
the permissions as desired.
There are too many variables to get into
the details of subscribing to shared
calendars in Google Calendar and
Microsoft Outlook, but check those links
for advice on getting started.
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